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1. Введение 
 
Трекер TR-101/TR-102 – компактное устройство с встроенными модулями GPS и GSM для удаленного пози-
ционирования человека.  
 
Текущие координаты (широта и долгота) передаются либо через SMS на мобильный телефон, либо на персо-

нальный компьютер по сети Интернет посредством GPRS1 (только TR-102), и затем используются картогра-
фическим ПО для отображения местоположения на карте.  
 
У трекера есть три кнопки быстрого дозвона и одна кнопка экстренного вызова. TR-101/TR-102 может ис-
пользоваться для быстрого поиска детей и пожилых людей. Область применения может быть значительно 
расширена для решения задач поиска или контроля перемещения людей, животных, автомобилей, курьеров, 

ценных грузов. 
 
Компания GlobalSat Technology Corporation (далее «GlobalSat») придерживается политики непрерывного раз-

вития, поэтому оставляет за собой право вносить любые изменения и улучшения в любое изделие, описанное 
в этом документе, без предварительного уведомления. 
 
Компания GlobalSat не несет ответственности за потерю данных или прибыли, а также за любой специаль-

ный, случайный, последующий или косвенный ущерб, чем бы он ни был вызван. 
 
Содержание этого документа представлено на условиях "как есть". Кроме требований действующего законо-
дательства, никакие иные гарантии, как явные, так и подразумеваемые, включая (но не ограничиваясь) не-
явными гарантиями коммерческой ценности и пригодности для определенной цели, не касаются точности, 
надежности или содержания этого документа. Компания GlobalSat оставляет за собой право пересматривать 
или изменять содержимое данного документа в любое время без предварительного уведомления. 

 
 

2. Особенности 
 

 GPS/GSM персональный локатор  

 GSM/SMS (TR-101) или GSM/SMS/GPRS связь (TR-102)  
 Всенаправленная высокочувствительная GPS антенна обеспечивающая отличное качество приёма 

сигналов спутников в условиях города  
 Применение новейших технологий и GPS чипсет последнего поколения SiRF Star III делают возмож-

ным точное определение координат даже в условиях слабых и переотраженных сигналов  
 Удаленное управление устройством через мобильный телефон или с помощью ПК в режиме on-line  
 Возможность приема входящих звонков для двухсторонней связи  

 Фильтрация входящих звонков – только 10 предварительно запрограммированных телефонных номе-
ров могут и осуществлять контроль его местоположения  

 Возможность скрытого наблюдения за движением объекта без установления связи с ним – мониторинг 
в режиме реального времени  

 Определение текущего местоположения трекера нажатием всего одной кнопки на ПК или отправкой 
одного SMS-сообщения  

 3 кнопки быстрого дозвона по предварительно запрограммированным телефонным номерам  
 GSM 850/1800 МГц (Европейская версия), GSM 900/1900 МГц (Американская версия) и GPRS класс 12 

(TR-102)  
 Кнопка SOS отправляет координаты и сигнал тревоги через SMS по трем предварительно записанным 

в памяти телефонным номерам (эти номера могут отличаться от номеров быстрого дозвона)  
 Подключение к ПК для настройки трекера и программирования номеров быстрого дозвона и отправки 

тревожного сообщения осуществляется через USB-порт (кабель mini-USB входит в стандартный ком-

плект поставки)  
 Возможность программирования временного интервала для автоматической отправки текущего поло-

жения владельца трекера. Например, можно запрограммировать отправку текущих координат 1 раз в 
час (только в режиме GPRS) 

 Сигнализация низкого уровня заряда батареи  
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Особенности ПО:  
 

Прилагающееся программное обеспечение (ПО) «Call Center» или «ТрекМастер», работающее под Windows 
98/2000/XP, способно одновременно отслеживать передвижения до 5 трекеров через SMS («ТрекМастер») 
или GPRS1 («Call Center» или «ТрекМастер») и отображать их положение на картах Google. Все права на кар-
тографические изображения принадлежат компании Google (www.google.com). 

 
 
Программа «Call Center» не является профессиональным ПО для контроля перемещения и предназначена 
только для настройки рабочих параметров и тестирования работы трекера TR-102.  
Для контроля перемещения объектов используйте Интернет-сервисы, перечисленные в Приложении 1. 
 

--------------------------------- 
1. Внимание! Для использования трекера TR-102 в GPRS режиме, ваш компьютер должен иметь 

РЕАЛЬНЫЙ IP-адрес!!! Этот адрес может быть статическим или динамическим. К примеру, 
Вы можете использовать трекер с бесплатным сервисом онлайн мониторинга 
www.GPShome.ru 

 

http://www.google.com/
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3. Различия TR-101/TR-102 
 
 

 TR-101 TR-102 

Кнопка SOS   

Двусторонняя голосовая связь по GSM каналу   

Контроль положения по SMS каналу   * 

Контроль положения по GPRS1 каналу -  

 
*. Если TR-102 в данный момент работает в режиме GPRS, он не будет посылать ответную SMS с определён-
ными координатами. Текущий режим (SMS или GPRS) настраивается в конфигурационной программе. 
 

 
 
Что выбрать пользователю 
 

Пользователь… TR-101 TR-102 

   имеет телефон сотовой связи   

   имеет доступ к компьютеру, подключённому к Интернет   

   нуждается в диспетчерском программном обеспечении* -  

   нуждается в подробной карте местности* -  

   имеет возможность установки ПО на сервер компании -  

 
*. Компании ООО «ГлобалСат» (Россия) и GlobalSat Technology Corporation (Taiwan) не предоставляют ука-

занное диспетчерское программное обеспечение и картографические материалы. ПО и карты вы можете при-
обрести у компаний, список которых представлен на сайте www.globalsat.ru. 
 
 
 
--------------------------------- 
1. Внимание! Для использования трекера TR-102 в GPRS режиме, ваш компьютер должен иметь 

РЕАЛЬНЫЙ IP-адрес!!! Этот адрес может быть статическим или динамическим. К примеру, 
Вы можете использовать трекер с бесплатным сервисом онлайн мониторинга 
www.GPShome.ru 
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4. Спецификации 

 

 

GSM модуль:  

Диапазон 
GSM 850/1800 МГц (Европейская версия),  

GSM 900/1900 МГц (Американская версия) 

GPRS class 12  

GPS приемник:  

GPS чипсет SiRF Star III  

Частота L1, 1575.42 МГц  

Количество каналов 20, "All-in-View"  

Антенна всенаправленная спиральная 

Точность:  

Определение скорости 0.1 м/сек, 95% (селективный доступ отключён)  

Определение времени 1 мкс, синхронизация по атомным часам GPS спутников  

Датум WGS-84  

Время захвата позиции:  

Обновление данных 0.1 сек.  

Горячий старт 1 сек., в среднем  

Тёплый старт 38 сек., в среднем  

Холодный старт 42 сек., в среднем  

Ограничения:  

Максимальная высота До 18000 м (60000 футов)  

Максимальная скорость До 515 м/с (1000 узлов)  

Максимальная вибрация 20 м/сек3  

Максимальное ускорение До 4g  

Характеристики окружающей среды:  

Температура эксплуатации - 20° ~ + 55°C  

Влажность 5 - 95%, не конденсированная  

Питание:  

Li-Ion аккумулятор 3.7 В, 1300 мАч  

Напряжение З/У 5 В 

Время работы в дежурном режиме до 100 часов (зависит от режима использования) 

Время работы в режиме разговора 5 ~ 6 часов  

Физические характеристики:  

Габариты 115 x 45 x 22.5 мм  

Светодиодная индикация 

- питание;  

- статус GPS;  

- статус GSM;  

Кнопки управления 

7 кнопок:  

- включение/отключение;  

- тревожная кнопка;  

- 3 кнопки вызова;  

- ответ/сброс звонка;  

- блокировка кнопок;  

USB порт мини USB порт для подключения к ПК  



 7 

5. Начало работы 
 
5.1 Комплектация 
 
Перед началом эксплуатации, обязательно проверьте комплектацию TR-101/TR-102. Если какой либо из ком-
понентов отсутствует или поврежден, свяжитесь с продавцом. 

 
1. Трекер TR-101/TR-102 
2. Аккумуляторная батарея 1300 мАч 
3. Кабель USB 
4. Зарядное устройство 220 В 
5. CD-ROM 

 
Дополнительно могут поставляться: 
 

6. Чехол на пояс 
7. Зарядное устройство от прикуривателя автомобиля 

 
 

 

 
 
 

 
 

 
 
 

 

1 2 3 
 
 

 

 

4 5 
 
 

 

 
6 7 
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Перед началом использования TR-101 необходимо проделать следующие опреации: установить SIM-карту и 
аккумуляторную батарею, полностью зарядить аккумуляторную батарею. 
 

5.2 Установка SIM-карты и аккумуляторной батареи 
 
 

                    
 
 

1. Легко нажмите на крышку батарейного отсека и сдвиньте её вниз. 
2. Вставьте SIM-карту в держатель. Защёлкните держатель SIM-карты. 
3. Установите аккумуляторную батарею, чтобы её контакты совпали с контактами в нижней части бата-

рейного отсека трекера. 

4. Установите на место крышку батарейного отсека и задвиньте её вверх до щелчка 
 
 
 
5.3 Зарядка батареи 
 

Для правильной работы трекера необходимо зарядить аккумуляторную батарею. Для этого включите прила-

гаемое зарядное устройство в гнездо трекера. Вилку зарядного устройства включите в сеть переменного тока 
220 В. Дождитесь, пока погаснет оранжевый светодиод. Время полной зарядки – до 10 часов.  

 
Внимание! Не используйте никакие другие аккумуляторные батареи, кроме входящей в комплект. 
Это может вывести прибор из строя.  
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6. Конструкция трекера 
 
6.1 Внешний вид 
 

 
 
 
 
 
 
 

 
 
 
 

 
 
 

 
 
 
 
 
 

 
 
 
 
 
 

 

 
 
 
 
 
 
 

 
 
 
 
 
 

 

 
 

1. Блокировка кнопок (HOLD) 
2. Микрофон 
3. Индикация состояния питания 
4. Индикация состояния GPS 

5. Индикация состояния GSM 
6. Кнопка питания. Для срабатывания необходимо удерживать кнопку 5-6 

секунд. 
7. Кнопка SOS. Для срабатывания необходимо удерживать кнопку 5-6 се-

кунд, пока не загорится красный светодиод. 
8. Крепление шнура для переноски 
9. Антенна GPS 

10. Динамик 

11. Кнопка ответа/окончания разговора/включения режима настройки 
12. Телефон 1/Прибавить громкость 
13. Телефон 2/Отключить микрофон 
14. Телефон 3/Убавить громкость 
15. Гнездо подключения питания 

16. Гнездо USB 
17. Крышка батарейного отсека 

9 

6 

7 
11 

1 
16 

15 

2 

10 

12 

13 

14 

5 

4 

3 

8 

17 
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6.2 Органы управления 
 
 

Кнопка питания Включает и отключает трекер.  
  
Кнопка SOS Этой кнопке вы можете присвоить 3 телефонных номера. При нажатии на кноп-

ку SOS, трекер определит вашу позицию и отправит её в виде SMS сообщения 
на эти номера. Сначала SMS будет отправлено на первый, потом на второй, за-
тем на третий. 

  
Кнопка отве-
та/окончания раз-

говора 

При поступлении входящего вызова нажмите эту кнопку (на 1-2 секунды), что-
бы начать разговор. По окончании разговора нажмите её снова. 

  
Телефон 1/ При-

бавить громкость 

Вы можете присвоить этой кнопке телефонный номер. При нажатии на неё, про-

изойдёт вызов абонента. Во время разговора нажатие на эту кнопку (на 1-2 се-
кунды) увеличивает громкость динамика.  

  
Телефон 2/ От-

ключить микро-
фон 

Вы можете присвоить этой кнопке телефонный номер. При нажатии на неё, про-

изойдёт вызов абонента. Во время разговора нажатие на эту кнопку (на 1-2 се-
кунды) отключает микрофон. 

  
Телефон 3/ Уба-
вить громкость 

Вы можете присвоить этой кнопке телефонный номер. При нажатии на неё, про-
изойдёт вызов абонента. Во время разговора нажатие на эту кнопку (на 1-2 се-
кунды) уменьшает громкость динамика. 

  

Индикация со-
стояния GSM 

Синий светодиод 
Горит постоянно: трекер включён, но ещё не установил связь с сетью GSM  
Мигает часто (1 сек.): трекер в режиме набора номера, отправки данных по 
SMS/GPRS или разговора 

Мигает редко (3 сек.): трекер находится в дежурном режиме 
  

Индикация со-
стояния GPS 

Зелёный светодиод 
Мигает: идёт поиск спутников и определение позиции.  
Горит постоянно (при этом синий мигает часто): трекер находится в online-
режиме GPRS 

  
Индикация со-
стояния питания 

Красный светодиод горит постоянно: батарея разряжена, необходимо зарядить. 
Оранжевый светодиод горит постоянно: подключено зарядное устройство, идёт 

зарядка батареи. По окончании зарядки оранжевый светодиод гаснет. 
Этот индикатор также используется для подтверждения правильного нажатия 
кнопки SOS и подтверждения получения SMS адресатом. При этом он загорается 
на 1-2 секунды и гаснет. 

  
Гнездо подключе-

ния питания 

Для зарядки аккумуляторной батареи необходимо вставить в это гнездо круглый 

штекер зарядного устройства и включить его в сеть 220 В. 

  
Гнездо USB Подключив трекер к персональному компьютеру с помощью USB кабеля, вы мо-

жете произвести его настройку с помощью прилагаемого программного обеспе-
чения. 

  
Блокировка кно-

пок 

Переключатель блокировки необходим для предотвращения случайного нажатия 

кнопок трекера. При включенной блокировке (переключатель сдвинут вниз по 
стрелке) любое нажатие кнопок будет сигнализироваться троекратным миганием 
всех светодиодов. Для разблокирования трекера, сдвиньте движок вверх. 
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7. Установка и работа с программой «Call Center» 
 
Программа «Call Center» не является профессиональным ПО для контроля перемещения и предназначена 
только для настройки рабочих параметров и тестирования работы трекера TR-102.  
Для контроля перемещения объектов Вы можете использовать трекер с бесплатным сервисом онлайн  
мониторинга www.GPShome.ru 

 
 
7.1 Установка драйвера USB 
 
 

 
 

               Меню установки 
 

 
 
             Диалоговое окно 1 
 

 
 
             Диалоговое окно 2 
 
1. Вставьте прилагаемый CD-ROM в привод. Автоматически загрузится меню установки. Кликните кнопку 

«Install USB Driver» для установки драйвера трекера. 
2. Появится диалоговое окно 1, для продолжения кликните «Next». 
3. По окончании процедуры установки появится диалоговое окно 2. На этом шаге может понадобиться пере-
загрузка компьютера. Выберите соответствующий пункт и кликните «Finish».  

http://www.gpshome.ru/
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7.2 Установка программы «Call Center» 
 
 

 
 

                  Меню установки 
 
 

 
 
          Диалоговое окно 1 
 

 

 
 

          Диалоговое окно 2 
 
 
1. Вставьте прилагаемый CD-ROM в привод. Автоматически загрузится меню установки. Кликните кнопку 
«Install PC Software» для установки программного обеспечения «Call Center». 
2. Появится диалоговое окно 1. Следуйте инструкциям на экране. 
3. По окончании процедуры установки появится диалоговое окно 2, кликните «Finish». 
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7.3 Работа с программой «Call Center» 
 
 

Пункт меню 
Панель инст-

рументов 
Описание 

File > Save File (KML) 

 

Экспорт полученных данных в файл формата KML 
для последующего отображения в приложении 
«Google Earth». Функция доступна только при 
включённом режиме «Search Records» 

File > Exit  Выход из программы «Call Center» 

View > GPRS Tracking 

 

Включение приёма данных, передаваемых треке-
рами по GRPS. Вы сможете видеть данные треке-

ров, находящихся в данный момент на связи. 

View > Show Map  

Если этот пункт выбран, полученные данные не-

медленно отображаются на картах 
maps.google.com или в приложении «Google 
Earth» 

View > Search Records 

 

Переключение в режим фильтрации исторических 
данных. Вы можете задать начальные и конечные 
дату и время и, кликнув «Inquire», получить от-

фильтрованные данные. 

Management > User Information 

 

Отображение информации о зарегистрированных 

в программе трекерах. Вы можете зарегистриро-
вать до 5 трекеров включительно. 

Management > User Edit  
Удаление зарегистрированных трекеров. Т.к. вы 
можете зарегистрировать только 5 трекеров, 
здесь вы можете удалить ненужные. 

Management > Setup 

 

Изменение настроек подключённого трекера (но-
меров телефонов, параметров GPRS) 

GPRS > Start  
Запуск приёма данных, передаваемых трекером 
по GPRS. Необходим, если вы используете в каче-
стве сервера этот компьютер. * 

GPRS > Pause  

Приостановка приёма данных, передаваемых тре-
кером по GPRS. Пока идёт приём данных, вы не 

сможете работать с настройками трекера, под-
ключённого к ПК по USB. 

GPRS > Send Command to TR-102  Отправка команды на трекер 

Map > Google Map  
Отображение позиции на карте сервера 
maps.google.com 

Map > Google Earth  
Отображение позиции на карте приложения 
«Google Earth» 

About  Информация о версии программы 

 
 

--------------------------------------- 
*. Внимание! Для использования трекера TR-102 в GPRS режиме, ваш компьютер должен иметь 

РЕАЛЬНЫЙ IP-адрес!!! Этот адрес может быть статическим или динамическим. К примеру, 
Вы можете использовать трекер с бесплатным сервисом онлайн мониторинга 
www.GPShome.ru 
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7.4 Основные настройки 
 
 

1. Вставьте SIM-карту в трекер. 
 
2. Присоедините USB-кабель одним разъёмом к трекеру, другим – к компютеру 
(предварительно установите драйвер USB, см. пункт 7.1). 

 
3. Включите трекер, нажав и удерживая кнопку питания. 
 

 Дождитесь, пока закончится процесс инициализации трекера и светодио-
ды перестанут мигать поочерёдно. 

 Для переход в режим настройки, нажмите и удерживайте кнопку «Кнопка ответа/окончания разгово-

ра» в течение 10-15 секунд, пока все три светодиода не станут мигать од-
новременно. 

 
4. Запустите программу «Call Center», кликнув два раза по ярлыку «TR102-Call 
Center» на вашем «Рабочем столе». 

 
5. Выберите пункт меню «Management > Setup», нажмите «Scan». Программа 

просканирует все имеющиеся в системе СОМ-порты и определит, к какому из них 
подключён трекер. 
 
6. Нажмите кнопку «Setup». Программа считает параметры трекера и откроет ок-
но настроек. 
 
7. Если SIM-карта не установлена, программа выдаст соответствующее сообщение. 

 

 
 
 

Внимание! Если SIM-карта защищена PIN-кодом, будет выведено окно «Enter SIM PIN», где нуж-
но ввести PIN-код.  

Будьте внимательны!!! Если PIN-код будет введён неправильно три раза, SIM-карта будет за-
блокирована. В этом случае обратитесь к вашему оператору сотовой связи. 
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Закладка «Information» 
 

 
 
 

Пункт Описание 

Module IMEI 
(IMEI номер) 

Уникальный номер GSM-модуля IMEI (International Mobile Equip-

ment Identity). 

Firmware Version 
(Версия прошивки) 

Версия прошивки трекера. 

Name 
(Название) 

Произвольное название трекера, которое передаётся в SMS со-

общении 

Phone 
(Телефон) 

Номер телефона, соответствующий SIM-карте трекера 

 
 

Закладка «Phone Mode» 
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Пункт Опции 
Значение  

по-умолчанию 
Описание 

Return Type 
(Режим работы) 

GPRS 
SMS 

TR-102 передаёт данные по GPRS. 

SMS TR-101/TR-102 передаёт данные по SMS. 

Answer Mode 
(Режим ответа) 

Off 

On 

При поступлении входящего вызова, трекер воспроиз-
водит краткий приглушенный сигнал и начинает пере-
давать координаты в режиме, определённом в пункте 
«Return Type». Пользователь не может ответить на вхо-
дящий вызов. 
При поступлении SMS, трекер начинает передавать ко-

ординаты в режиме, определённом в пункте «Return 
Type». 

On 

При поступлении входящего вызова, трекер воспроиз-
водит звуковой сигнал, и пользователь может ответить 
на звонок.  
При поступлении SMS, трекер определяет позицию и 

передаёт координаты в режиме, определённом в пункте 
«Return Type». 

GPS Wake Up Time 
(Период переопре-
деления коорди-

нат) 

5 ~ 30 30 

Время в минутах, через которое происходит включение 
GPS приёмника и переопределение координат (обнов-
ление позиции в памяти), если трекер работает в режи-
ме SMS или в дежурном режиме GPRS (Stop Connect ...).  

Return Count 
(Время определе-

ния координат) 
1 ~ 10 3 

Время в минутах, в течение которого трекер будет пы-
таться определить позицию. Если позиция не определе-
на, в сообщении это будет указано и трекер отправит 
последние зафиксированные координаты. 

Check Phone List 
(Проверка номера) 

Off 

Off 

Трекер будет отвечать на запрос координат с любых те-
лефонов. 

On 
Трекер будет отвечать на запрос координат только с те-
лефонов, указанных в пунктах «Phone Number1» ~ 
«Phone Number10» (см. ниже) 

Time Zone 

(Местное время) 

On 

On 

Данные, отсылаемые трекером, содержат местное вре-
мя. 

Off 
Данные, отсылаемые трекером, содержат время UTC 
(Coordinated Universal Time). 

 
 
Формат SMS, отправляемого трекером. 
 

Position Report:  
TR102 
2007/1/15 0:21:3 
55.74743,037.62477 
GPS fixed 
 

Строка 1. Тип сообщения: «Position Report» - ответ на запрос координат, «Emergency Report» - пользователь 

нажал кнопку SOS. 
Строка 2. Название трекера, задаваемое в настройках (см. ниже). 
Строка 3. Дата и время определения позиции в формате «yyyy/m/d h:m:s» (лидирующие нули отсутствуют). 
Строка 4. Широта и долгота позиции в градусах*.  
Строка 5. Показывает, определена или нет позиция. «GPS fixed» - определена. «GPS not fixed» - не опреде-
лена (при этом дата, время и координаты соответствуют последней определённой позиции). 

 
 
* Если ввести эти координаты в строку поиска в программе «Google Earth» или на странице maps.google.com, 
отобразится соответствующая позиция на карте. 
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Закладка «Phone Return» 
 

 
 

Пункт 
Значение  

по-умолчанию 
Описание 

SOS Number 1~3 
(Номер SOS 1~3) 

 Если пользователь нажал кнопку SOS, трекер попытается 

определить позицию; результат будет передан последова-

тельно в виде SMS на 3 заданных номера (последовательно 

на первый, второй и третий). Могут быть заданы от одного 

до трёх номеров. 

Quick Dial 1~3 
(Быстрый набор 

1~3) 

 Если пользователь нажал кнопку быстрого набора, будет 

набран номер, записанный в соответствующем поле. Могут 

быть заданы от одного до трёх номеров. 

 

Закладка «Phone List» 

 

 
 
На этой закладке задаются номера телефонов, котрые имеют право запросить определение координат треке-
ром. 

 

Пункт 
Значение  

по-умолчанию 
Описание 

Phone Number 
1~3 

(Телефон 1~3) 

 Эти номера повторяют заданные вами на закладке «Phone 

Return» в пунктах Quick Dial 1~3 (Быстрый набор 1~3). 

Phone Dial 4~10 
(Телефон 

4~10) 

 Здесь вы можете задать ещё 6 телефонных номеров, с кото-

рых разрешается получать запрос на определение позиции. 

 
Номера телефонов задаются в международном формате, например: 
 

+79161234567 или +74959876543 
 



 18 

Закладка «Parameter1» 
 

 
 
На этой закладке задаются параметры трекера для работы по GPRS. 
 

Пункт 
Значение  

по-умолчанию 
Описание 

GPRS Port 
(Порт GPRS) 

5000 
Номер порта. Должен совпадать с номером порта, ис-
пользуемым программой Call Center или вашим серве-
ром. Может иметь значения от 1 ~ 65536. 

GPRS apn 

(Точка входа APN) 
 Точка входа APN GPRS (см. ниже) 

GPRS user name 
(Логин) 

 Логин GPRS (см. ниже) 

GPRS user password 
(Пароль) 

 Пароль GPRS (см. ниже) 

GPRS dns1 

(Параметр DNS1) 
 Адрес DNS1 (см. ниже) 

GPRS dns2 
(Параметр DNS2) 

 Адрес DNS2 (см. ниже) 

 
Основные параметры настроек GPRS для Московского региона: 
 

 МТС Билайн Мегафон 

Точка входа APN internet.mts.ru internet.beeline.ru 
internet (internet.ltmsk — 

для тарифных планов Лайт) 

Логин mts beeline gdata 

Пароль mts beeline gdata 

DNS1 можно не указывать можно не указывать уточняйте у оператора  

DNS2 можно не указывать можно не указывать уточняйте у оператора 

 
Настройки GPRS других операторов сотовой связи и регионов уточняйте в службе поддержки этих операто-

ров. 

 
 
 



 19 

Закладка «Parameter2» 
 

 
 
На этой закладке задаются дополнительные параметры трекера для работы по GPRS. 
 

Пункт 
Значение  

по-умолчанию 
Описание 

GPRS Return Mode 
(Режим GPRS) 

Stop connect 

Варианты отчёта трекера по GPRS (расшифровку смот-
рите ниже): 
 Immediate report (Онлайн) 

 Period report (Онлайн + период) 
 Stop connect (Спящий) 
 Stop connect and set period report (Спящий + пери-

од) 
 

GPRS Interval Time 
(Период отчёта данных) 

60 

Время в секундах, через которое трекер будет включать 

GPS приёмник для определения координат, а результаты 
передавать на сервер. Допустимы значения от 60 до 
86400 секунд (1 сутки). 

GPRS Server Host Name 
(URL или IP сервера) 

 

Адрес сервера, на который трекер будет передавать 
данные. Может задаваться в двух вариантах: 

 IP: например, 62.35.128.15 
 URL: например, tr.no-ip.info (при использовании 

DDNS-сервисов) 

 
 Immediate report (Онлайн) – после включения трекер определяет координаты, соединяется с сер-

вером, отправляет отчёт и остаётся постоянно на связи, ожидая указаний сервера (периодической 
отправки координат не происходит, параметр GPRS Interval Time игнорируется). 
 

 Period report (Онлайн + период) - после включения трекер определяет координаты, соединяется с 

сервером, отправляет отчёт, остаётся постоянно на связи, ожидая указаний сервера, переопределяет 
и отправляет на сервер координаты с периодом, заданным в пункте GPRS Interval Time. 
 

 Stop connect (Спящий) – после включения трекер определяет координаты и переходит в спящий 
режим (периодической отправки координат не происходит, параметр GPRS Interval Time игнорирует-
ся). Чтобы принудить трекер отправить отчёт, необходимо послать на него SMS либо сделать звонок 
(если Answer Mode = Off). После передачи отчёта на сервер, трекер остаётся на связи несколько се-
кунд, в течение которых сервер может изменить режим работы трекера, подав соответствующую ко-
манду (см. файл «TR-102 GPRS Access command V 1.4.pdf»).  
 

 Stop connect and set period report (Спящий + период) – после включения трекер определяет ко-
ординаты, соединяется с сервером, отправляет отчёт и переходит в спящий режим. По окончании пе-
риода ожидания, заданного в пункте GPRS Interval Time, трекер переопределяет координаты и от-
правляет их на сервер, после чего опять переходит в спящий режим на заданное время. 
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Телефон 1 

Телефон 2 

Телефон 3 

8. Работа с трекером 
 
8.1 Включение/Отключение 

 
Для включения TR-101/TR-102, нажмите и удерживайте 3 секунды кнопку пита-
ния. Процесс включения будет сопровождаться последовательным перемигива-
нием всех трёх светодиодов сверху вниз. После включения будет медленно ми-
гать синий светодиод, обозначая дежурный режим GSM модуля. После включе-
ния GPS модуль будет в течение 3 минут пытаться определить текущую пози-
цию, в это время будет мигать зелёный светодиод. Если позиция определена, 

зелёный светодиод загорится на 2-3 секунды и погаснет. Если позиция не опре-
делена, GPS модуль попробует определить её снова через 30 минут. Рекоменду-
ем производить включение TR-101/TR-102 на открытом месте для уверенного определения координат. 
 
Для отключения TR-101/TR-102, нажмите и удерживайте 3-5 секунд кнопку питания. Процесс отключения 

будет сопровождаться последовательным перемигиванием всех трёх светодиодов снизу вверх.  
 

 
 
8.2 Ответ на входящий вызов/Окончание разговора 
 

 При поступлении входящего вызова буден слышен звуковой сигнал. 
Для ответа нажмите на Кнопку ответа. 

 
 Для окончания разговора нажмите на эту кнопку ещё раз. 

 
 
 
8.3 Регулировка громкости 
 

 Во время разговора нажмите кнопку «+» для увеличения громкости ди-
намика. 
 

 Во время разговора нажмите среднюю кнопку для отключения микро-
фона. Если микрофон отключён, собеседник вас не слышит. Для вклю-
чения микрофона нажмите эту кнопку ещё раз. 
 

 Во время разговора нажмите кнопку «-» для уменьшения громкости ди-
намика. 

 
Внимание! Для регулировки громкости и отключения/включения микрофона требуется нажатие на кнопку 
длительностью 1-2 секунды. 
 

 

8.4 Исходящий вызов 
 

 Если вы задали с помощью настроечного ПО телефонные номера быстро-
го набора, вы можете вызвать любого из трёх абонентов. Для этого на-
жмите и удерживайте в течение 1 секунды соответствующую кнопку.  

 

 
 
 
8.5 Отправка тревожного SMS 
 

 Если вы задали с помощью настроечного ПО телефонные номера для от-

правки сигнала SOS, вы можете отправить тревожное SMS сообщение на 
них. Для этого нажмите и удерживайте в течение 2 секунд кнопку SOS. 

 Для подтверждения правильного нажатия 2 раза мигнёт красный светоди-

од. 
 После этого TR-101/TR-102 попытается определить текущую позицию и 

отправит данные последовательно на заданные номера.  

 В подтверждение доставки SMS трекер мигнёт красным светодиодом. 
 Если TR-101/TR-102 не смог определить текущую позицию, будут отправ-

лены SMS с текстом «GPS not fixed» и последними определёнными координатами и временем. 
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Как происходит отправка тревожного SMS? 

 
1. Для подтверждения правильности нажатия кнопки SOS, красный светодиод мигнёт 2 раза. 
2. Трекер начнёт определять позицию (мигает зелёный светодиод). Если позиция определена, зелёный 

светодиод останется горящим на 5-6 секунд, после чего погаснет. 

3. Трекер начнёт передачу SMS сообщения (синий светодиод мигает часто). 
4. Трекер переходит в ждущий режим (синий светодиод мигает редко). 
5. Если получено подтверждение доставки SMS, мигнёт красный светодиод. 
6. Если в течение заданного в настройках времени (Пункт «Retourn Count», по-умолчанию – 3 минуты) 

координаты не были определены, трекер отправит SMS с последними определёнными координатами и 
строкой «GPS no fixed». 

 
 
Формат SMS, отправляемого трекером. 
 
Position Report:  

TR102 
2007/1/15 0:21:3 

55.74743,037.62477 
GPS fixed 
 
Строка 1. Тип сообщения: «Position Report» - ответ на запрос координат, «Emergency Report» - пользователь 
нажал кнопку SOS. 
Строка 2. Название трекера, задаваемое в настройках (см. ниже). 
Строка 3. Дата и время определения позиции в формате «yyyy/m/d h:m:s» (лидирующие нули отсутствуют). 

Строка 4. Широта и долгота позиции в градусах*.  
Строка 5. Показывает, определена или нет позиция. «GPS fixed» - определена. «GPS not fixed» - не опреде-
лена (при этом дата, время и координаты соответствуют последней определённой позиции). 
 
 

* Если ввести эти координаты в строку поиска в программе «Google Earth» или на странице maps.google.com, 

отобразится соответствующая позиция на карте. 
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9. Возможные проблемы и их решение 
 
 
 

Проблема Причина Решение 

При нажатии любой кнопки 
мигают все светодиоды 
(красный, желтый, синий) 
одновременно 

Включен режим HOLD 

(блокировка нажатия 
кнопок) 

Передвиньте движок HOLD правой стороне корпуса 
в верхнее положение (против стрелки) 

Все светодиоды мигают 

одновременно 
 

Возможны 2 варианта: 
1. Не вставлена SIM-карта 

2. SIM-карта вставлена, но имеет защиту PIN-
кодом 

 

Решения: 
1. Вставить рабочую SIM-карту с активированной 

услугой GPRS (приобретается у любого оператора 
сотовой связи), предварительно сняв блокировку 

PIN-кодом, с помощью другого мобильного 
телефона. 

2. Снять блокировку PIN-кодом. Для этого 

необходимо вставить SIM-карту в любой мобильный 
телефон и через меню снять блокировку. 

Cиний светодиод горит по-
стоянно 

Прибор не зарегистриро-
вался в сети GSM. Сла-
бый сигнал, либо отсут-
ствует GSM покрытие. 

Используйте трекер в местах с уверенным GSM по-
крытием. 

После включения трекера 
процесс инициализации (по-
очерёдное мигание светодио-
дов) продолжается неопреде-
лённо долго 

В трекере новая прошив-

ка, а для настройки ис-
пользовалось старое ПО: 
ТрекМастер версии ниже 
1.2 или CallCenter без 
пометки GlobalSat Russia 

2 

Скачать свежую версию ПО в разделе «Техпод-
держка» на сайте www.globalsat.su. Установить на 
ПК. Подключить трекер к ПК, включить, пока идёт 
поочерёдное мигание светодиодов, произвести на-
стройку параметров трекера в программе CallCenter 

Во время разговора не могу 

сделать громкость динамика 
выше/ниже 

Во избежание ложного 
срабатывания в трекере 
сделана задержка сраба-
тывания кнопок.  

Для регулировки громкости динамика в процессе 

разговора необходимо нажимать на соответствую-
щую кнопку ( + или - ) в течение 1-2 секунд 

Не могу отправить сообщение 

SOS 

Во избежание ложного 
срабатывания в трекере 

сделана задержка сраба-
тывания кнопок. 

Для отправки SOS необходимо нажать и удержи-
вать (5-10 секунд) кнопку SOS (кнопка слева-
вверху с изображением конверта), пока не заго-
рится красный светодиод, подтверждающий сраба-
тывание. 

Не могу выключить трекер 

Во избежание ложного 
срабатывания в трекере 
сделана задержка сраба-

тывания кнопок. 

Для отключения трекера необходимо нажать и 
удерживать (5-10 секунд) кнопку питания (слева-
внизу кнопка с изображением кружка и палочки), 
пока не все светодиоды не начнут мигать по оче-
реди. 

При входящем вызове нажи-
маю кнопку ответа, а мелодия 
продолжает играть. Я нажи-
маю кнопку ответа снова, 
подношу к уху а там никого 
нет… (связь разорвалась) 

 

При входящем вызове кнопка ответа срабатывает 
сразу. Из-за конструктивных особенностей мелодия 
доигрывает несколько тактов. 
Решение: при входящем вызове нажимаете кнопку 
ответа, ждёте пару секунд окончания проигрыва-
ния мелодии и подносите трекер к уху. 
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10. Техническая поддержка 
 
Страница технической поддержки GlobalSat в интернете: http://www.globalsat.ru/support 
 
Загрузка программного обеспечения и документации: http://www.globalsat.ru/download/gps-gprs-trekery  
 
Если у Вас возникли вопросы, обратитесь в нашу Службу Технической Поддержки, и мы поможем Вам. 

 
Email Технической Поддержки:  support@globalsat.ru 
 
Skype Технической Поддержки:  globalsat_support 
 
Телефон Технической Поддержки:  +7 (495) 755-9204 

 
Служба Технической Поддержки работает для вас по рабочим дням с 10.00 до 18.00 (время московское). Все 

обращения на Email в другое время обрабатываются в начале следующего рабочего дня. 
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